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 True/False Questions 
 Each of the following statements is either true or false. Indicate your 
choice by circling T or F.

     1. AutoCorrect automatically changes “THis” to “This” and “monday” to 
“Monday.”  

    2. You can edit an AutoText entry by redefining an existing AutoText entry.  

    3. The Grammar button is located on the Home tab.  

    4. To start the thesaurus, press F7 .  

    5. The thesaurus finds synonyms for words.  

    6. AutoComplete suggests a complete word or phrase for a date or an 
AutoText entry.  

    7. You can choose to check only the spelling of a document, without 
checking the grammar.  

    8. You can insert a date automatically by pressing Ctrl + D .      

 Short Answer Questions 
Write the correct answer in the space provided.    

  1.   Which function key starts a spell check?  

  2.   Which option in the Spelling and Grammar dialog box skips over an 
incorrectly spelled word?  

  3.   Which dialog box is used to display and delete AutoText entries?  

  4.   When the Building Blocks Organizer dialog box is open, what is the 
easiest way to display the entries in a gallery in alphabetical order?  

  5.   Which tab on the Ribbon lists the Date and Time command?  

  6.   Which Word feature corrects accidental usage of Caps Lock ?  

  7.   Which task pane is used to access references such as dictionaries and 
encyclopedias?  

  8.   What must you do to a word before using the thesaurus?     
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Concepts Review  
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            Critical Thinking       
  Answer these questions on a separate page. There are no right or wrong 
answers. Support your answers with examples from your own experience, 
if possible.   

  1.   Some educators believe the spell-checking feature in word processing 
programs will lead to decreased spelling skills in future generations. Do 
you think students’ spelling skills will deteriorate? Explain your answer.  

  2.   Review several Word documents that you recently created. Study the 
content of the documents, and determine if there is any repetitive 
content. Would it be time effective to create AutoText entries for this 
text? Why or why not?      

  Exercise 3-14 
  Use AutoCorrect and AutoComplete.         

  1.   Start a new document.  

  2.   Key the following sentences (including the errors): 

     CAmpbell’s Confections is a candy manufacturer in western pennsylvania 
with three major divisions. quality chocolates are produced for retail, 
wholesale, and fundraising.   

  3.   Press Caps Lock , and key the following sentence as shown. 

     there are 24 campbell’s confections retail stores located in three states.   

  4.   Continue the paragraph by keying the following sentence in all 
lowercase letters, letting AutoCorrect capitalize the first letter of each 
sentence. When you see the AutoComplete tip for the months, press 
Enter  and continue keying. 

     from january through december, you can visit any of our stores or Web 
site to find sales promotions for our boxed chocolate candy, chocolate 
favors, or novelty items.   

  5.   Start a new paragraph. Key the following sentence (including the errors 
in the first two words) 

    thisyear, consider a visit to Campbell’s Confections and tour our factory.   

  6.   Save the document as  [your initials]  3-14  in your Lesson 3 folder.  

  7.   Submit your work, and close the document.     

 Skills Review 
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 Exercise 3-15 
 Use AutoText.

   1.   Open the file  Letter - 2 . Replace [Date] with the current date.  

   2.    Change the formatting for the entire letterhead to small caps and 
dark blue. Select the first line of the letterhead, and change the font 
size to 14.  

   3.    At the second blank paragraph mark below “Dear Mr. Matthews,” key 
the following sentence, 

Thank you for your interest in Campbell’s Confections, western 
Pennsylvania’s most popular chocolate factory and candy store.   

   4.    Using the text you just keyed, create an AutoText entry by following 
these steps:  

  a.    Select the text “Campbell’s Confections.” Do not select the comma at 
the end of the text.  

  b.   Click the  Insert  tab on the Ribbon, and click  Quick Parts .  

  c.   Click  AutoText , and click  Save Selection to AutoText Gallery .  

  d.   Key the AutoText entry name  [your initials]  cc  (Example: dhcc).  

  e.    Select  AutoText  in the  Gallery  drop-down list. Select  Normal.dotm  in 
the  Save in  drop-down list.  

  f.    Click  OK .  

   5.    Press Enter  twice at the end of the first paragraph to start a new 
paragraph.  

   6.    Click the  Insert  tab on the Ribbon. Click  Quick Parts , and click  Building 
Blocks Organizer .    

   7.    Click the  Gallery  column heading to sort the list. 
Locate and click  [your initials]  cc  to select the AutoText 
entry. Click  Insert . 

    8.    Complete the sentence by pressing the Spacebar  and 
keying the following text: 

    is your full-service candy store, offering the greatest 
selections of milk, dark, white, and sugar-free 
chocolates. We also create specialty chocolates with 
logos, monograms, or custom artwork.   

   9.   Start a new paragraph, and key the following text. When you key 
“ [your initials] cc,” an AutoComplete box displays. Press Enter  when 
the AutoComplete box appears to accept the text insertion. 

     The enclosed brochures will provide more information about   [your 
initials]   cc. We look forward to helping you place your next order.   

   10.    Press Enter  twice, and key  Sincerely yours, .  

NOTE

 An alternative method to insert the 
AutoText entry is to click the Insert tab, 
and click Quick Parts. Point to AutoText, 
and a list of AutoText entries displays. 

Click to select the AutoText entry. 
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   11.   Press Enter  four times, and key the following information: 

     Lydia Hamrick 
Customer Service   

   12.    Press Enter  twice, key  [your initials]  in lowercase, and press Enter .  

   13.    Control the AutoCorrect function with the AutoCorrect Options 
button  by following these steps:  

  a.    Move the I-beam over your first initial until you see the small blue 
box.  

  b.    Move the pointer to the small blue box until the AutoCorrect Options 
button  appears.  

  c.    Click the button icon and choose  Undo Automatic Capitalization .    

   14.   On the line below your initials, key  Enclosures (2) .  

   15.   Delete the AutoText entry by following these steps:  

  a.    Click the  Insert  tab on the Ribbon, and click  Quick Parts . Click 
 Building Blocks Organizer .  

  b.   Select the AutoText entry,  [your initials]  cc , from the list.  

  c.   Click  Delete  and click  Yes . Click  Close .    

   16.   Work with Actions by following these steps:  

  a.    Move the I-beam over the street address “Main Street,” and then 
press the right mouse button to display a shortcut menu.  

  b.   Choose  Additional Actions .  

  c.   Click  Add to Contacts .  

  d.   Review the content of the Contact tab, and close the window.  

  e.   Click  No  when you are asked if you want to save the changes.    

   17.   Save the document as  [your initials]  3-15  in your Lesson 3 folder.  

   18.   Submit and close the document.       

 Exercise 3-16 
  Spell-check and grammar-check a document.   

  1.   Open the file  Favors - 3 .  

  2.   Spell-check and grammar-check the document by following these steps:  

  a.   Click the  Review  tab on the Ribbon.  

  b.    Click the Spelling Grammar button .  

  c.    When Word locates the first misspelled word, choose  Campbell’s  
from the Suggestions list and click  Change . Next Word finds a 
misspelling, “ocasions.” Click  Change .  

  d.    When Word locates “sugarfree” as an error, click in the “Not in 
Dictionary” section, and key a hyphen after the “r” and click  Change .  
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  e.    Correct the spelling of “wraped,” “ribon,” and “minature.” When 
Word locates “ment” as an error, click in the “Not in Dictionary” 
section, and press Backspace  to delete the extra space and to form the 
word “assortment.” Click  Change .  

  f.    When Word locates “carmel” as an error, edit the text to read 
“caramel.” Click  Change .  

  g.    Continue checking the document, changing spelling, deleting words, 
or correcting grammar as appropriate.    

  3.   Select the title, and change the font size to 14 and the font color to 
dark blue.  

  4.   Save the document as  [your initials]  3-16  in your Lesson 3 folder.  

  5.   Submit and close the document.     

 Exercise 3-17 
 Use the thesaurus.  

  1.   Open the file  Summer .  

  2.   Use the thesaurus to find another word for “wonderful” by following 
these steps:  

  a.   Select “wonderful” in the last sentence of the first paragraph.  

  b.   Press Shift + F7 .  

  c.     Point to a synonym, and click the drop-down arrow to the right of the 
word.  

  d.   Choose  Insert  from the drop-down list.  

  e.    Close the Research task pane by clicking the Research task pane 
Close button .    

  3.   Start a new paragraph at the end of the document and key  Come and 
enjoy the fun!   

  4.   Select the word “fun.”  

  5.   Click the  Review  tab on the Ribbon. Click the Thesaurus button .  

  6.   Replace “fun” with a noun listed in the Research task pane. Remember 
to click the down arrow and choose  Insert . Close the Research task pane.  

  7.   Save the document as  [your initials]  3-17  in your Lesson 3 folder.  

  8.   Use the Research task pane to define a word by following these steps:  

  a.   Press Alt  and click “ethnic” in the first paragraph.  

  b.    Choose  Encarta Dictionary  from the All Reference Books 
drop-down list.  

  c.   Read the definition.  

  d.   Close the task pane.    

  9.   Submit your work, and close the document.      
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 Exercise 3-18 
Create an AutoText entry, and check grammar and spelling.   

   1.   Create a new document, and key the text  Campbell’s Confections  and 
press Enter .  

   2.   Select the text and the paragraph marks, and format them as 12-point 
Cambria.  

   3.   Select the text “Campbell’s Confections” (excluding the paragraph 
marks), and create an AutoText entry named  [your initials]  cc .  

   4.   Go to the end of the document, and key the text shown in Figure 3-13. 
Include the corrections. Wherever “ [your initials] cc” appears, key the 
name of the AutoText entry you just created, pressing Enter  or F3  to 
expand the entry. 

 Lesson Applications 

 Figure 3-13 
  The best handmade chocolate candy inWestern Pennsylvania 

is made by  [your initials] cc. The family owned business 

opened its first store in 1957 on Main ST in grove city 

Pennsylvania. 

  [your initials] cc specialize in assorted chocolate-covered 

nuts, creams, melt-a-ways, and truffles. Additional 

selections include chocolate-covered prezels, peppermint 

patties, cherries, pecanettes, croquettes, and peanut 

butter cups. You can also buy several varieties of hard 

and soft candies.  [your initials] cc takes pride inusing 

the finest ingredients in its recipes. 

 Visit one of  [your initials] cc candy stores to make your 

candy selections. The candy stores are open 6 days a week. 

In addition to buying your candy at the stores, you can 

call our toll-free number at 800-555-2025 or visit our Web 

site at www.campbellsconfections.biz.    
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   5.   Spell-check and grammar-check the document.  

   6.    Format the title as 16-point bold, small caps, and add 
a text effect.  

   7.    Format “Campbell’s Confections” in small caps 
throughout the document.  

   8.   Delete the AutoText entry you created.  

   9.    Save the document as  [your initials]  3-18  in your Lesson 3 folder.  

   10.   Submit your work, and close the document.       

 Exercise 3-19 
  Spell-check and grammar-check a document, and use the Research 
task pane.   

  1.   Open the file  Fountain - 2 .  

  2.   Spell-check and grammar-check the document, making the appropriate 
corrections.  

  3.   Proofread the document to ensure the document does not contain errors.  

  4.   Use the thesaurus to look up the word “finest” in the second sentence of 
the paragraph that begins “Campbell’s Confections.”  

  5.   Capitalize each word in the first line of the document.  

  6.   Format the title as 14-point bold, small caps with expanded character 
spacing.  

  7.   Save the document as  [your initials]  3-19  in your Lesson 3 folder.  

  8.   Submit and close the document.     

 Exercise 3-20 
 Format a document as a letter, check spelling and grammar, and use 
the thesaurus.  

   1.   Open the document  Letter - 3 .  

   2.   Position the insertion point on the second blank paragraph mark after 
the letterhead text.  

   3.   Click the  Insert  tab, and click the  Date and Time  command. Click the 
third format in the Date and Time dialog box.  

   4.   Press Enter  four times, and key the text in Figure 3-15. Include one blank 
line after the address and the salutation. (Refer to Appendix B, 
“Standard Forms for Business Documents,” for correct letter format.)  

 REVIEW 

 Use the Repeat command F4  to format 
the name. 

  Figure 3-15   Mr. George Henderson 
 3850 Fifth Avenue 
 Altoona, PA 16602 

 Dear Mr. Henderson:   
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  5.   At the end of the last paragraph, press Enter  twice. Key the closing 
 Sincerely , and press Enter  four times. Key  Lydia Hamrick , and press 
Enter . On the next line, key  Customer Service . Press Enter  twice, and key 
your initials in lowercase. Press Enter  and key  Enclosure .  

   6.   Use the AutoCorrect Options button  to undo the capitalization of 
your first initial.  

   7.   Check the spelling and grammar of the document, making the 
appropriate corrections.  

   8.   Use the thesaurus to find a synonym for “delighted” in the first sentence 
of the document.  

   9.   Save the document as  [your initials]  3-20  in your Lesson 3 folder.  

   10.   Submit and close the document.     

 Exercise 3-21    Challenge Yourself 
  Create an AutoText entry, and check the grammar and spelling of a 
document.   

   1.   Open the file  WV Stores .  

   2.   Select the complete address and contact information for the Clarksburg 
store, and create an AutoText entry named  [your initials]  clark . Be sure to 
store the AutoText entry in the Normal.dotm.  

   3.   Close the document and open the file  Refer .  

   4.   Place the insertion point on the second paragraph mark after the 
letterhead text, and insert the date using the Ribbon. Use appropriate 
format for a business letter.  

   5.   Press Enter  four times and key the inside address listed in Figure 3-16.  
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  Figure 3-16   Ms. Jill Gresh 
 360 Lincoln Street 
 Grafton, WV 26354   

  6.   Press Enter  twice, and key  Dear Ms. Gresh: .  

   7.   Verify that there is one blank line between the inside address and the 
salutation and one blank line between the salutation and the first 
paragraph.  

   8.   Position the insertion point at the beginning of the paragraph that 
begins “Please let.”  

  9.   Insert the AutoText entry  [your initials]  clark . Press Enter  if necessary to 
insert a blank line.  
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  10.   Spell- and grammar-check from the beginning of the document.  

  11.   Delete the AutoText entry “ [your initials] clark.”  

  12.   Save the document as  [your initials]  3-21  in your Lesson 3 folder.  

  13.   Submit your work, and close the document.      

 On Your Own 

  In these exercises you work on your own, as you would in a real-life 
business environment. Use the skills you’ve learned to accomplish the 
task—and be creative.   

 Exercise 3-22    
 Write a summary about a book you have recently read, but before you start 
the summary, create an AutoCorrect entry for a word you know you often 
misspell. Next create an AutoText entry for a phrase you use frequently. Use 
these stored items in the summary as often as you can. Delete the entries 
when you have finished. Spell- and grammar-check your document. Format 
the document, save it as  [your initials]  3-22 ,   and submit it.   

 Exercise 3-23    
 Create a new document, and create an AutoText entry to be used as a 
salutation in a letter. Create an AutoText entry to include a complimentary 
closing and signature line. Delete the text keyed for the AutoText entries 
from the document, and write a letter to a local government official. Insert 
the date using the Date and Time feature on the Insert tab of the Ribbon. 
Key the inside address, and insert the AutoText entry you created for the 
salutation. Key the body of the letter, and insert the AutoText entry you 
created for the closing. Delete the AutoText entries when you have finished. 
Spell- and grammar-check your document. Format the document using 
correct business letter format. Save the document as  [your initials]  3-23 ,   
and submit your work.   

 Exercise 3-24    
 Locate a Web site about one of your hobbies or interests. Summarize the 
information from the site in a Word document. Add a title to the document, 
and apply character formatting. Use the thesaurus to insert synonyms. 
Spell- and grammar-check the document. Proofread the document. Save 
the document as  [your initials]  3-24 , and submit your work.      

hin19294_ch03_WD078-WD105.indd Page WD-105  24/04/10  12:01 PM user-f463hin19294_ch03_WD078-WD105.indd Page WD-105  24/04/10  12:01 PM user-f463 /Volumes/203/MHRL033/ros69760/0070969760/ros69760_pagefiles/Volumes/203/MHRL033/ros69760/0070969760/ros69760_pagefiles


